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Overview

This article walks through the steps to find recurring *donation* records in the Contributions List, and how to build a monthly donation report
using the format and pivot tools to show what donors have given month-by-month.

As of the time this article was written there are two merchant gateways that you can use with Trail Blazer that support recurring credit card

donations, they’re Authorize.Net and Vanco Services.

Example monthly recurring donation report:
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Monthly donor report. You can now export/print or chart the report.

First
Mame

Bread of...

) Sort 53 Wrap | B Export 2 Print
Contribution Amount by Donor ID/First Mame/Last Name by Contribution Year Month

Last
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Central ... 1,500.00 00 150,00 150.00 150.00 150.00 300,00 .00 150.00 15000 150.00 150,00 150.00 150,00 .00
Crossro.., 800,00 00 100.00 100.00 100.00 00 200,00 .00 300,00 00 00 00 00 00 .00
Emmaus... 1,200.00 00 100.00 100.00 100.00 100.00 200,00 .00 100.00 100,00 100.00 100.00 100.00 100,00 .00
First Ba... 1,500.00 00 125.00 125.00 125.00 125.00 125.00 125.00 125.00 125.00 125.00 125.00 125.00 125.00 .00
Living G... 4,400.00 00 00 400.00 400.00 400.00 400,00 400.00 400.00 400,00 400.00 400.00 400.00 400,00 .00
Melaleuca 11135 00 10.50 9.75 11.05 00 20.55 7.57 8.81 10.20 6.83 9.85 6.04 2.80 .00
Meridia... 2,130.00 00 180,00 180.00 180.00 150.00 360,00 150.00 150.00 00 150.00 150,00 150.00 300,00 .00
Meridia... 2,135.00 00 150,00 230.00 110.00 120.00 800,00 .00 100.00 100,00 150.00 125.00 125.00 125.00 .00
Riversid... 600,00 00 00 30.00 30.00 50.00 100,00 30.00 00 100,00 30.00 50.00 30.00 50,00 .00
Sterry M... 700,00 00 50.00 150.00 30.00 50.00 100,00 .00 50.00 50.00 30.00 50.00 30.00 50.00 .00
The Purs... 1,200.00 00 100.00 100.00 100.00 100.00 100,00 .00 200.00 100,00 100.00 100.00 100.00 100,00 .00
Boyce &... | Bailey 9,000.00 00 750,00 750.00 750,00 750,00 750,00 750.00 750,00 750,00 750,00 750,00 750.00 750,00 .00
Ronald .. |Bird 300,00 00 25.00 .00 25.00 25.00 50,00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 .00
William ... | Boehm 360,00 00 30.00 30.00 30.00 30.00 30.00 30.00 30.00 30.00 30.00 30.00 30.00 30.00 .00
Vance Brown 1,717.50 00 101.50 296.00 22900 176.00 135,00 184.00 111.00 111.00 111.00 37.00 111.00 111.00 .00
Curt & K... | Clark 500,00 00 00 .00 00 100.00 100,00 100.00 100.00 100,00 100.00 100.00 100.00 100,00 .00
David & ... | Cook 350,00 00 50.00 .00 100.00 00 50,00 100.00 00 100,00 30.00 50.00 30.00 00 .00
Charles ... |Coon 275,00 00 00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 .00
Bob & L. | Deakins 175.00 00 00 25.00 25.00 25.00 50,00 .00 25.00 25.00 00 00 00 00 .00
Greg &.. | Dismu... 500,00 00 100.00 100.00 100.00 100.00 100,00 100.00 100.00 100,00 100.00 00 00 00 .00
Jessie & ... | Eddy 350,00 00 00 30.00 30.00 50.00 50,00 30.00 50.00 50.00 30.00 50.00 30.00 50,00 .00
Marcy Emery 300,00 00 00 30.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 .00
Joan Emry 1,100.00 00 00 100.00 100.00 100.00 100,00 100.00 100.00 100,00 100.00 100.00 100.00 100,00 .00
Gary & ... |Fisher 300,00 00 00 25.00 30.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 .00
James Freem... 600,00 00 00 75.00 75.00 75.00 75.00 75.00 75.00 75.00 75.00 00 00 00 .00
Christop... | Fullmer 2,275.00 00 175.00 175.00 175.00 175.00 350,00 175.00 175.00 175.00 175.00 175.00 175.00 175.00 .00
Judith Gillam 430,00 00 40.00 .00 40.00 40.00 80.00 40.00 40.00 40.00 40.00 40.00 40.00 50,00 .00
Lloyd & ... | Grant 300,00 00 25.00 .00 25.00 25.00 50.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 .00
Michael Hachi... 220,00 00 00 20.00 20.00 20.00 40.00 .00 20.00 20.00 20.00 20.00 20.00 20.00 .00
Henry &... | Hartso... 240,00 00 20.00 20.00 20.00 20.00 20.00 20.00 20.00 20.00 20.00 20.00 20.00 20.00 .00
Tom & Jan | Hickey 1,200.00 00 100.00 100.00 100.00 100.00 200,00 .00 100.00 100,00 100.00 100.00 100.00 100,00 .00
Brent & ... | Ho 500,00 00 75.00 75.00 30.00 150.00 50.00 75.00 50.00 50.00 30.00 50.00 100.00 125.00 .00
Rod & B.. |Jensen 3,600.00 00 300,00 300.00 300.00 300.00 300,00 300.00 300.00 300,00 300.00 300,00 300.00 300,00 .00
Kent & K... | Kalpak... 350,00 00 25.00 30.00 25.00 25.00 25.00 25.00 25.00 50.00 25.00 00 30.00 25.00 .00
Bob & K. | Kuche.., 600,00 00 50.00 30.00 30.00 00 100,00 30.00 50.00 50.00 30.00 50.00 30.00 50,00 .00
Julian &... | Laca 480,00 00 40.00 40.00 40.00 40.00 40.00 40.00 40.00 40.00 40.00 40.00 40.00 40.00 .00
Mal & Pat | Lancas... 2,500.00 00 00 200.00 00 00 2,000.00 200.00 00 00 200.00 00 00 200,00 .00
71l
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« Tip: this article provides a variety of useful SQL queries you can utilize to filter your data. Most of the examples in this SQL tutorial are requests
that customers have had over the years, which require using the SQL tab.

Steps

Open the Contributions list.
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gt Settings  Help

Application Menu kot

»» g Organization
» & Calendar/Tasks
[» % Canvassing
4 % Donor
[&E Donars
@ Addresses
@ Househaolds
EEI Donor Relationships
4 " Contributions/Pledges
@y Contributions
@ Contribution Allocations
@y Contribution Matches
@y Contribution Motifications
EJ Pledges
] Pledges, Detail
[Z Thank You Letter - Contributions
» [ Reports
5 (7 Product Sales
5 > Logs
i+ 5y Communications
[» iﬁ Financial
i &g System Manager
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Under the General tab click the Recurrence drop-down, select Monthly & Monthly / Sustaining, click [OK], and then click [Search] to populate the
list with all the recurring monthly donations in your database. In this example there were 222 monthly recurring monthly donations.

5

< Search v, Reset | & New [B|E 0 | 1) ¥ @ File + Edit - | 0 | Applyto Pledges | Contributions

1

I : [
Favnritl"-l'lemr'_.r.l'HDnDr | 'Dﬂ'ierl Gateway | Contact | SaL | Recurrence: ]
A [C] <not assigned:= =
@ I [7] Single i
[C] Wweekly T
~ Date Range: [-< custom, according to dates belows v] :F‘deu[:ts: | ’-: ignorex v] [ ":'-.!'ﬂekly ! Sustaining p
O B> O O Recurrence: || <multiple items selected [y]  [|[C]Biweskly 3 =
Cycle: <ignores ﬂ Deductibility: ’ <ignores T] a
Event: <ignore= E Exclude Event: ’-: ignore= - Monthly / Sustaining
. . . E U=y
Amount Range:  minimum « to  maximum - Alloc. Fund: |-<|gncure:» E| [F] Quarterly / Sustaining
Batch Code: [ Annually
2 [7] Annually [ Sustaining

EE Edit @ Sort @ Format - 3 Wrap @3 Export & Print @ Pivot

« Tip: you can filter this report further by things like date-range if necessary:
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You can filter the monthly donor report further by date-range.

<3» Search %, Reset | 4k New o= ) ¥ @ File » Edit - | 0 | ApplytoPledges | Contributions

Q

Favorites General I Memaory/Honar | 'Dtherl Gateway | D{:nnrl SGEL |
Q

* Date Range:

[‘l‘ear-tu-nlate - ] Products: [ <ignare=

1/ 1/2017 - <3 8/ 9/2017 ~ | Recurrence: |<igr‘|c|re:»

Cycle: <iinnre> : Deductibility: [{ignure:»
Event: <ignore= Exclude Event: [-cigrmre:»

Amount Range:  minimum » to maximum - Alloc. Fund: <ignore=
Batch Code:

EN RN RN EN/RN

=i Edi - S5 (& i i

=8 Edit ) Sort B Format ~ =3 Wrap a Export &Prlnt ) Pivot |
Contributions [ 526 records found ]

Amount/

Amount Tax
Deductible

Event
Mame

Donor  Last First

] Mame MName Check # Street

o

14,2017 David & .. 2100 Lucere..

113,2017 Christop... ! . 957 Haven ...
Gene & J.. : : 2739 PFilgri...



http://www.trailblz.com/kb

& TrailBlazer

Organe. Leverage. Succeed. Query and Report for Monthly Recurring Donations — Nonprofit Only

After generating the list of recurring donations, click the [Format] drop-down and select Columns...
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=3 Search . Reset | 9F New

Q

Favorites General I Memory/Honar I Oﬂ'rerl (Gateway | DDnDrl SaL |

Q9

(Bl = W) File = Edit - | 0 | Apply to Pledges | Contributions

~ : ’< custom, according to dates belows= v] Products: <ignores -
Date Range:
E <= [E+  Recurrence: <multiple items selected:E
Cycle: <ignore> ﬂ Deductibility: [< ignore> - ]
Event: <ignorex |Z| Exclude Event: [< ignare> - ]
Amount Range:  minimum + to maximum - Alloc. Fund: |<ignore> |Z||
Batch Code:

FPayment Recurrence .

Method Type City
- = — _____ =
Add or remove columns, apply formatting, or specify column attributes.

SO0 T Credit Card Eagle Jii) 33616
11... | D »B Save As... 100.00 | Credit Card IMaonthly 2125 5P... | Boise ] 83709
11... | Sn % Assign as default... 50.00 | Credit Card IMonthly 2490 Alp... | Eagle v} 83616
11... | DoGgh... | Thomas... a,/11/2014 100.00 | Credit Card Monthly 2125 5P... | Boise i) 83709
11... | Smith Tyler & ... G/14/2014 50.00 | Credit Card IMonthly 2490 Alp... | Eagle i) 83616
12... | Fondren | Joanne G/28/2014 10.00 | Credit Card Monthly 1306 SA.. | Caldwell |ID §36054...
12... | Dough... | Thomas... 9/11/2014 100.00 | Credit Card Monthly 2125 5P... | Boise D 83709
12... | Smith Tyler & ... 9/14/2014 50.00 | Credit Card Monthly 2490 Alp... | Eagle jin] 33616
12... | Fondren | Joanne 9/29/2014 10.00 | Credit Card Monthly 1806 SA.. | Caldwell | ID 836054..
12... | Dough... | Thomas... 10/11/2014 100.00 | Credit Card Monthly 2125 5P... | Boise jin] 83709
12... | Smith Tyler & ... 10/14/2014 50.00 | Credit Card Monthly 2490 Alp... | Eagle jin] 33616
12 McMo... | Jim & C.. 10/23/2014 25.00 | Credit Card Monthly 1085 Sta... | Meridian | ID 33642
12... | Prosch Gregar... 10/27,/2014 25.00 | Credit Card Monthly 1863 Ru... | Boise jin] 33709
12... | Pease Gene &L, 11/7/2014 25.00 | Credit Card Maonthly 2739 Pil... | Boise jin] 33704
12... | Dough... | Thomas.. 11/11/2014 100.00 | Credit Card Manthly 2125 5 P... | Boise jin] 83709
12, | McMa.., | Jim & C.. 11/24/2014 25.00 | Credit Card Monthly 1085 Sta.. | Meridian | ID 33042
12... | Prosch Greagor.., 11/28/2014 25.00 | Credit Card Manthly 1868 Ru... | Boise jin] 83709
12... | Smith Tyler & .. 12/2/2014 50.00 | Credit Card Maonthly 2490 Alp... | Eagle i) 33616
12... | Pease Gene & 12/8/2014 25,00 | Credit Card Maonthly 2739 Pil... | Boise v} 83704 bIZ.Com/kb 8
12... | Dough... | Thomas... 1211/2014 100,00 | Credit Card Monthly 2125 5P... | Boise D 83709
12.. | McMo.., | Jim & C.., 12/24/2014 25.00 | Credit Card IMaonthly 1085 Sta.. | Meridian | ID 83042

12... | Prosch Gregaor... 12/28/2014 25.00 | Credit Card Monthly 1865 Ru... | Boise bin] 83709
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Make sure that these columns are selected, and then click [OK]:
- First Name
- Last Name
- ContributionYearMonth
- DonorID (not show, but included by default)
- Amount

KNOWLEDGE BASE www.trailblz.com/kb 9
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1. Make sure that these columns are included for the report:
- First Name

- Last Name

- Donor ID

- ContributionYearMonth

- Amount

9 Column Selection -
e -

Columns | Format |

Table Caolumns [Contribution]
= —= (3] Amout

=& |[J] ContributionDate
Contributionld
Contribution'YearManth
] Include

Jc:i:wi = oo — (Nat shown but also inclug

P @ Donor E| is F rst Name, LESt NEIITIE-

@ Address [Default Display]
@ Address [Home] Domor ID‘)
@ Address [Mailing]

@ Address [Reqistration]
F Address IWark]

10
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After the columns listed above are added to the grid, click the Pivot button.

KNOWLEDGE BASE www.trailblz.com/kb 11



http://www.trailblz.com/kb

& TrailBlazer

Organize.Leverage. Succeed. Query and Report for Monthly Recurring Donations — Nonprofit Only

I] <3 Search Y. Reset | 4k New o File = Edit - | ©) | Applyto Pledges | Contributions

Y
Favorites General | Memory/Honor | Oﬂmrl Gateway | Ml saL |
Qo
~ Date Range: ’ [<custum, according to dates belows v] Products: <ignorex -
| 1 [ Recurrence: <multiple items selected:lzl
Cycle: <ignores E Deductibility: <ignorex v]
Event: <ignore> E Exclude Event: | <ignore>
Amount Range:  minimum v to maximum - Allge. Fund: <ignorex E|

Batch Code:

%E Edit @ Sort @ Format ~ =3 Wrap DE Export & Print]

TN Paymen Create pn.rot table. Strest city State Zip Contribution

Method Code Year Month

,T,— Crough... | Thomas.. 6/10/2014 100.00 | Credit Card Monthly . |EBoise l— 83709 201406
11... | Smith Tyler & . 6/13/2014 50.00 | Credit Card Manthly 2490 Alp... | Eagle D 83elE 201406
11... | Dough... | Thomas... 771172014 100.00 | Credit Card Manthly 2125 5P... | Boise D 83709 2014/07
11... | Smith Tyler &t .., 7/14/2014 50.00 | Credit Card Monthly 2490 Alp... | Eagle (] a3elo 2014,07
11... | Dough... | Thomas... 8/11/2014 100.00 | Credit Card Manthly 2125 5P... | Boise D 83709 2014,08
11... | Smith Tyler & ... 8/14/2014 50.00 | Credit Card Manthly 2490 Alp... | Eagle j(a] 33616 2014,/08
12... | Fondren | Joanne 8§/258/2014 10.00 | Credit Card Maonthly 1806 SA.. | Caldwell |ID &36054... | 201408
12... | Dough... | Thomas... 9/11/2014 100.00 | Credit Card Maonthly 2125 5P... | Boise j(a] 83709 201409
12... | Smith Tyler & ... 9/14/2014 50.00 | Credit Card Maonthly 2490 Alp... | Eagle j(n] 83616 201409
12... | Fondren | Joanne 9/29/2014 10.00 | Credit Card Maonthly 1806 SA.. | Caldwell | ID &36054... | 2014,09

| 12... | Dough... | Thomas... 10/11/2014 100.00 | Credit Card Maonthly 2125 5P... | Boise D 83709 201410
12... | Smith Tyler & ... 10/14/2014 50.00 | Credit Card Monthly 2490 Alp... | Eagle j(a] 3616 201410
12.. | McMo... | Jim & C... 10/23/2014 25.00 | Credit Card Monthly 1085 Sta... | Meridian | ID §3642 201410
| | 12.. | Prosch Gregor... 10/27/2014 25.00 | Credit Card Maonthly 1868 Ru... | Boise D 83709 201410
12... | Pease Gene 8. 11/7/2014 25.00 | Credit Card Maonthly 2739 Pil... | Boise D 83704 201411
12... | Dough... | Thomas... 11/11/2014 100.00 | Credit Card Monthly 2125 5P... | Boise D 83709 201411
12.. | McMao... | Jim & C... 11/24/2014 25.00 | Credit Card Monthly 1085 Sta... | Meridian | 1D 53642 201411
12... | Prosch Gregor... 11/25/2014 25.00 | Credit Card Monthly 1368 Ru... | Boise i) 83709 201411
12... | Smith Tyler & ... 12/2/2014 50.00 | Credit Card Monthly 2430 Alp... | Eagle )] 43616 2014412
12... | Pease Gene &L.. 12/5/2014 25.00 | Credit Card Monthly 2739 Pil... | Boise o] 83704 2014412 12
12... | Dough... | Thomas... 12/11/2014 100.00 | Credit Card Monthly 2125 5P... | Boise D 83709 201412
12... | McMao.. | Jim & C.., 12/24/2014 25.00 | Credit Card Maonthly 1055 Sta.. | Meridian | 1D 43642 201412
12... | Prosch Gregor., 12/25/2014 25,00 | Credit Card Monthly 1568 Ru... | Boise D 83709 201442
- . ==l P - —_— - e - PR P - P P - s - - - - — - ——a - 1 3
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Under the Row Label tab select Donor ID, First Name, and Last Name.

Create Pivot Table

RnwLahds“:danabels | Data |

ID ~ | &
Date il
Donor (D
Donor.Donorta | Donor D
SEIECt DDI"IOI' ID, First Name Donor.Firstlame | First Mame

I Ml
Last Name and .ﬁ.nmunt Donor.LastMame |Last Name
'

Open Pledges [Per Donor]

Caolumn Heading

First Name. o
[C] City

[] State
[[] Zip Code

Cwverall Progress
s
Wwaiting for user input...

Step Progress
s

KNOWLEDGE BASE www.trailblz.com/kb 13
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Under the Column Labels tab select Contribution Year Month.

Create Pivot Table

Row Labels| Column Labels |

Amount e Pivot Table Columns

| Open Pledges [Per Do 1
St?::t [Per Donor] - Column Heading
Street 2 |n> | ContributionYe... | Contribution Ye...

City

State

Zip Code

Cycle

Mon Monetary Type
Payment Method
Recurrence Type
Contributor TypelD
Contribution Year Month

Cwerall Progress
[
\wiaiting for user input...

Step Progress
[

KNOWLEDGE BASE www.trailblz.com/kb 14
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Under the Data tab select Amount, and then click [OK] to generate the pivot report.

KNOWLEDGE BASE www.trailblz.com/kb 15
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Create Pivot Table

Row Labels | Column Labels

Show count of occurrences Pivot Table Data

| Columns | [ Coumn  Total
L[] Amount

Cwverall Progress
[
‘wiaiting for user input...

Step Progress
[

KNOWLEDGE BASE www.trailblz.com/kb 16
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The report will display your recurring monthly *donors* with the total amount they’ve donated each month. My finished example is below (only

the first 15 months display in the screenshots as my report goes all the back to 2012 when my monthly recurring donations started).

Export / Print

Example final report of all monthly donors with donation amounts month-by-month.

™

) Sot S3Wrap | &% Export 7 Print
Contribution Amount by Donor ID/First Name/Last Name by Contribution Year Month
Danar Rt Last SUM SUM SUM SUM SUM SUM SUM SUM SUM SUM SUM SUM SUM SUM SUM SUM
D Name Name (Amount] [Amount]  [(Amount] [Amount} [Amount} [Amount} [&mount) [&mount}  [(Amount] [Amount) [(Amount] [(Amount] [Amount) [Amount) [&mount) [Amount}
2014/06 201407 2014/08 2014/09 2014/10 2014411 201412 2015/01 201502 2015/03 2015/04  2015/05 2015/06 2015/07 2015/08
3 Rock & Terry | Brown 150.00 00 00 00 00 00 .00 00 .00 00 00 .00 .00 00 .00 00 [

173 Curt & Ken... | Clark 900.00 00 00 00 00 A0 .00 A0 .00 00 A0 .00 .00 A0 .00 100.00
233 Thomas & D... | Dougherty 1,100.00 100.00 100.00 100.00 100.00 100.00 100.00 100.00 100.00 00 100.00 100.00 100.00 00 .00 00
257 Christopher... | Fullmer 1,400.00 00 00 00 00 00 .00 00 .00 00 00 .00 .00 00 .00 00
455 Stacey McCullough 765.00 00 00 00 00 A0 .00 A0 .00 00 A0 .00 .00 A0 .00 00
730 Tyler & Heat... | Smith 1,800.00 50.00 50.00 50.00 50.00 50.00 .00 50.00 50.00 50.00 50.00 50.00 50.00 50.00 50.00 50.00
867 Ryan & Julie | Wilhite 75.00 00 00 00 00 00 .00 00 .00 00 00 .00 .00 00 .00 00
5789 Mick & Deni... | Gaviola 200.00 00 00 00 00 A0 .00 A0 .00 00 A0 .00 .00 A0 .00 00
5805 Jim & Carolyn | McMonigal 300.00 00 .00 .00 .00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00
6199 Dana & Cathi | Danzer 600.00 00 00 00 00 00 .00 00 .00 00 25.00 .00 50,00 00 50.00 25.00
7438 Joanne Fondren 20.00 00 00 10.00 10.00 00 .00 00 .00 00 00 .00 .00 00 .00 00
7752 Gregory & 5... | Prosch 300.00 00 00 00 00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00
7739 Todd And A... | Vitek 200.00 00 00 00 00 00 .00 00 .00 00 00 .00 .00 00 .00 00
7955 Robert Barros-Bailey 1,000.00 00 00 00 00 00 .00 00 .00 00 00 .00 .00 00 .00 125.00
8090 Steven & M... | George 100.00 00 00 00 00 A0 .00 A0 .00 00 A0 .00 .00 A0 .00 00
8215 Kerri Demarse 250.00 00 00 00 00 00 .00 00 .00 00 00 .00 .00 00 .00 00
8323 Gene & Jac.. | Pease 750.00 00 00 00 00 00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00 25.00
9772 Oregon Trail | Church Of ... 1,975.00 00 00 00 00 A0 .00 A0 .00 00 A0 .00 .00 A0 .00 00
9968 Kevin & Ser... | Wang 150.00 00 .00 .00 .00 00 .00 00 .00 00 00 .00 .00 00 .00 00
9971 David & Car... | Lang 315.00 00 00 00 00 00 .00 00 .00 00 00 .00 .00 00 .00 00
9938 Hayden Stout 25.00 00 00 00 00 00 .00 00 .00 00 00 .00 .00 00 .00 00

|E | 21 | | 12,375.00 150.00 150.00 160.00 160.00 200,00 175.00 22500 | 225.00 | 125.00 250,00 | 225.00 | 275.00 125.00 175.00 375.00

You can export, print, and graph the pivot report using the buttons on the top tool strip.
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Return back to the contribution list you built in the previous steps in order to save both the format and the search query for future use.
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B) Settings  Help

Application Menu «“

Elk L=

Tasks

> [ Dashboard

1> & Organization

» 8 Calendar/Tasks
[ @ Canvassing

[ % Donor

I % Communications
» il Financial

i & System Manager

OpenWindows

OQ& s |

4 "B Contributions

Amount by D

l[:)unur :;;:I n I.';srtn n tSAUn'::unl} Is.'ltun!:unﬂ tSAUr::unt] ;Ur:;unﬂ [Amount] [Amount) [Amaunt) [Amount]
2014/06 201407 201408 2014/09 2014410 2014411 2014412
E Rock & T.. |Brown 150.00
173 Curt & Ke... | Clark 900.00 00 00 00 00 .00 00 00
238 Thomas .. |Doughe. 1,100.00 100.00 100,00 100.00 100,00 100,00 100.00 100,00
287 Christop... | Fullmer 1,400.00 00 00 00 00 00 00 00
485 Stacey MecCulla... 765.00 00 00 00 00 .00 00 00
730 Tyler & H... | Smith 1,800.00 50.00 50.00 50.00 50,00 50.00 00 50.00
867 Ryan & ... | Wilhite 75.00 00 00 00 00 .00 00 00
5789 Nick & D... | Gaviola 200,00 00 00 00 .00 00 00
5305 Jim & Car... | McMoni... 300.00 00 00 00 00 25.00 25.00 25.00
6199 Dana & C... | Danzer 600,00 00 00 00 00 .00 00 00
7438 Joanne Fondren 20,00 00 00 10.00 10,00 00 00 00
7752 Gregory ... | Prosch 300.00 00 00 00 00 25.00 25.00 25.00
7789 Todd And... | Vitek 200,00 00 00 00 00 .00 00 00
7955 Robert Barros-.. 1,000.00 00 00 00 00 .00 00 00
8090 Steven & ... | George 100.00 00 00 00 00 .00 00 00
8215 Kerri Demarse 250.00 00 00 00 00 00 00 00
3323 Gene & ). | Pease 750.00 00 00 00 00 .00 25.00 25.00
9772 Oregon T... | Church ... 1,975.00 00 00 00 00 .00 00 00
9968 Kevin & 5... | Wang 150.00 00 00 00 00 00 00 00
9971 David & ... |lang 315.00 00 00 00 00 .00 00 00
9938 Hayden Stout 25.00 00 00 00 00 00 00 00
10037 Tony & Br... | Ball 50.00 00 00 00 00 .00 00 00
22 12,425.00 150,00 150,00 160,00 160,00 200,00 175.00 225.00

4 L}
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To save the search query as a favorite, expand the Advanced Functions tool strip, and click blue the [Save] button.
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2. Save the monthly recurring donation
query as a favorite.

<3» Search %, Reset | 4k New = [ L) ¥ @ & File - Edit - | & | Applyto Pledges | Contributions

\‘E’@_JEAEEE-lH sQL |

Favortes General | Memary/Honar | Dtherl Ga‘tﬂ'ﬁ'a‘;_f | D{:m::rl SaL |
1 9

~ Date Range:

<ignore:=

[< custom, according to dates below> - Products: [
@<= + Recurrence: |
Cycle: <jignorex Deductibility: [ <ignore=

<multiple items selected:

Event: <ignaorex Exclude Event;

<ignore=

[ i B

Amount Range:  minimum + to maximum Alloc. Fund: <ignore=

Batch Code:

=4 Edi .28 @ - :
S Edit [ Sort ) Format ~ S3Wrap | 9% Export 2 Print @antl

Contributions [ 222 records found ]

Create a descriptive name, and then click [Save]. My example is below which | called “Recurring Monthly Donations”.
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1. Create a descriptive name for the query.

@ Save Search Criteria as a “Favm‘ite"

Recurring Monthly Donations

[] Private

Saved Search Mame Created Chwned By User

@ Recuming donors (calculated) for past 365 days 201770602 Admin, Admin
@Spumdic Donors (ess than 5times in past Sroling years) 201770504 Admin, Admin

You can reload the saved search in the future under the Favorites tab.
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@) Settings Help
Application Menu

Bl kB

Tasks

B Dashboard

i» g Organization

b 8§ Calendar/Tasks 1] Favorite Searches
[ % Canvassing %

Recurring donors [calculated) for past 365 days
4 % Donar Recurring Monthly Donations
@El Dronars

Sporadic Donors (less than b times in past 5 rolling years)
@ Addresses
@ Households

@ Donor Relationships You can reload the saved query in

4 By Contributions/Pledges .
@ Contributions the future under the Favorites tab.
@ Contribution Allocations
@@y Contribution Matches
@ Contribution Motifications
Fledges
Pledges, Detail
[=] Thank You Letter - Contributions
: [ Reports E8 Edit @Sort @Format - =3 Wrap Bﬁ Export &Print @Pivot |
[» £ Product Sales J re
O (| [ {MC CO I O C
I > Logs
I+ (% Communications
. a Finandial D Date Donar Last

. Amounty Tax
D Mame First Mame M Amount Deductible Event
i % System Manager

< || v Search %, Reset | 4k New oo @ File » Edit - | ) | Apply to Pledges | Contributions
B e < EFEH @

General | Memory/Honar I Dﬂ'lerl Gateway I DDHDFI SQL I

Favontes

o ¢ @

To save the format click the [Format] drop-down > Save As...
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Organize, Leverage. Succeed.

T3 | Fle « Edit - T
“3» Search . Reset  <p New N = B File = Edit ~ | 0 | Applyto Pledges | Contributions
Q

Favorites General | Memory/Honor | Clﬂ'lerl Gateway I Dnnc:rl SaL |

9
~ < custom, according to dates belows Products: [< ignores

; E <= + Recurrence: |<multiple items selected:
<ignaore= Deductibility: [ <ignore=

<ignore= Exclude Event: [-c ignore=

minimum - to  maximum Alloc. Fund: |<igr1::ure:»

1

‘(

=i Edi - =3 laf i i

=8 Edit R Sort [EEF Format ~|=3 Wrap E Export & Print | 27 Pivot |
Contributions [ 222 {S!Stfl'l'l Format:=
FE) Columns..

Payment Recurrence ) Zip Caontribution
Method Type e Ly SIEE Code Year Month

-E: Select saved... L
[ 100.00 | Credit Card Monthly 2125 5P... |Buoise 1D 83709 201406
= D

Credit Card Monthly 2490 Alp... | Eagle 201406

mount

| ## Savehs.. Credit Card | Monthly 21255P... | Boise 2014/07
5 @ Assign as default., : Credit Card Monthly 2490 Alp... | Eagle 201407

Dé—mm T - m Save the current format under a specified name _EE SP. |Boise 2014/08

Smith Tyler & ... 8/14/2014 50.00 | Credit Card Monthly 2490 Alp... | Eagle 201408
Fondren | Joanne 8/28/2014 10.00 | Credit Card Monthly 1806 SA... | Caldwell 2014/08

Dough... | Thomas... 9/11,/2014 100.00 | Credit Card Monthly 2125 5P... | Boise 2014/09
Smith Tyler & ... 9/14/2014 50.00 | Credit Card Monthly 2490 Alp... | Eagle 2014,/08
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Organize, Leverage. Succeed.

Give the format a descriptive name and click [Save]. In this example I called it “Ready for Pivot”.

——

) Save Format
Mame: | Ready faor Pivat I

7 General Fund & Grants
) Ready for Pivot
EER Tax Deduct and Event

You can reload the format in the future by clicking the [Format] drop-down > Select Saved...
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¥

<3» Search Y. Reset | ok New o= | L) ¥ i File ~ Edit - | 0 | ApplytoPledges | Contributions

Favorites General | Memory/Honor | 'Dtl'rerl Gateway I D{:norl SaL I

[-= custom, according to dates belows v] Products:

[-= ignore= -

~ Date Range:
T [E Recurrence: |-<mu|ti|:|le items selected:E
Cycle: " <ignores E Deductibility: [-cignure:» -
Event: <ignorex |z| Exclude Event: [-< ignore= v]
Amount Rangs:  minimum * to  maximum - Alloc. Fund: |<ignore:» |E||
Batch Code:

I 4

«System Format>

2

—  anont o e e Swet  ay s B,
li 100.00 | 2014,/06 Maonthly Credit Card 2125 5 Petr... |Boise l? 83709
17.. | | Save 50.00 | 2014/06 Manthly Credit Card | 2490 Alpor... | Eagle ID | 83616
118.. »E Save As... 100,00 | 2014/07 Maonthly Credit Card 2125 5 Petr... | Boise I |&3709
118, @ Assign as default.., 50.00 | 201407 Monthly Credit Card 2490 Alpor... | Eagle [} 83616
119.. T eAII0I¥ T Dough... | Thomas ... 100.00 | 2014,/08 Monthly Credit Card 2125 5 Petr... | Boise D 83709
119.. 5/14/2014 | Smith Tyler & H... 50.00 | 2014,/08 Monthly Credit Card 2490 Alpor... | Eagle i} 83616
120, 5/28/2014 | Fondren | Joanne 10.00 | 2014,08 Monthly Credit Card 15806 SAND... | Caldwell |ID 53805...
120.. 9/11/2014 | Dough... | Thomas ... 100.00 | 2014,/09 Monthly Credit Card 2125 5 Petr... | Boise i} 83709
1A1.. 9/14/2014 | Smith Tyler & H... 50,00 | 2014,/09 Maonthly Credit Card 2490 Alpar... | Eagle j(n] 83616
122.. 9/29/2014 | Fondren | Joanne 10.00 | 2014,/09 Monthly Credit Card 1806 SAMD... | Caldwell |ID B3605...
122, 10/11/2014 | Dough... | Thomas ... 100.00 | 201410 Monthly Credit Card 2125 5 Petr... | Boise i} 83709
122, 10/14/2014 | Smith Tyler & H... 50.00 | 201410 Manthly Credit Card 2490 Alpor... | Eagle ] 53616
1 =1 P o I S e P e e
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Choose the format you previously saved, and click [Select and Close].

e Select Format

@ < System Format >
@Geneml Fund & Grants
i=% Heady for Pivat
fEF) Tax Deduct and Event

2

| Select || SelectandClose | (D) Cancsl |

L r— | —
Cedt Card 11506 ND.. | Golawell | D _|55605..

Take a look at the related resources below for a wide variety of other articles and videos related to this topic.
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999

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources

Related Resources

Article: Advanced Queries — the SQL Tab

Article: SQL Wildcards

Article: Creating and Saving Default Formats for Reporting with the Grid

Article: Search Query — New Donors This Month, and This Year (Primarily for Nonprofits)
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Article: How to Create a Donor LYBUNT Search Query (Donors Who Gave Last Year But Unfortunately Not This Year) and How to Save and Load it as
a Search Favorite

Article: Building a Search Query for ‘First Time Donors’ THIS Year — Save and Load it as a Favorite & Add it to your Dashboard

Article: Save and Load a Search Query as a (Dynamic) Search Favorite
Article: How to Delete or Rename a Search Favorite (Query)
Article: What Donors Have Increased Giving Over Last Year

Article: How to Use the New Dashboard Features — Adding Graphs and Metrics with Drag-and-Drop

Video: Reporting 105 — Pivots — summary reporting

Video: Getting Starting 105 — Queries with an AND condition
Video: Reporting 102 — Quick Reports and Export

Video: Getting Started 104 Queries with wildcards

Video: Favorites Deleting Saved Queries

Video: Getting Started 102 Beginning Queries - Nonprofit

Video: Reporting 104 — Joined tables
Video: Search — Contribution AndOR (donated in 1 time period but not another)

Trail Blazer Live Support

© Phone: 1-866-909-8700

@ Email: support@trailblz.com

Bl Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
E1 Twitter: https://twitter.com/trailblazersoft
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@ TFGIIBlazer Query and Report for Monthly Recurring Donations — Nonprofit Only

Organize, Leverage. Succeed.

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.
Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live

interactive trainings.

* This service is included in your contract.
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